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INTRODUCTION

The Xerox 700 Digital Color Press with Integrated Fiery Color Server media pack includes a 
set of software utilities that allow you to manage the Xerox 700 Digital Color Press with 
Integrated Fiery Color Server, as well as the print workflow and content of jobs on the 
Xerox 700 Digital Color Press with Integrated Fiery Color Server.

This document provides an overview of how to install, configure, and use the following 
Integrated Fiery Color Server utilities:

• Command WorkStation, Windows Edition

• Command WorkStation, Macintosh Edition

• Remote Scan

• Fiery Bridge

• Hot Folders

• WebTools
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Terminology and conventions
This document uses the following terminology and conventions.  

Term or convention Refers to

Aero Integrated Fiery Color Server (in illustrations and examples)

Digital press Xerox 700 Digital Color Press

Integrated Fiery Color Server Xerox 700 Digital Color Press with Integrated Fiery Color Server

Mac OS Apple Mac OS X

Titles in italics Other documents in this set

Windows Microsoft Windows 2000, Windows XP, Windows Server 2003, 
Windows Vista

Topics for which additional information is available by starting Help 
in the software

Tips and information

Important information

Important information about issues that can result in physical harm to 
you or others
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About this document
This document covers the following topics:

• Command WorkStation, Windows Edition: Monitoring and managing the print workflow of 
jobs on the Integrated Fiery Color Server.

• Command WorkStation, Macintosh Edition: Monitoring and managing the print workflow 
of jobs on the Integrated Fiery Color Server.

• Remote Scan: Retrieving a scan on the digital press from a remote computer on the 
network. Includes the Scan TWAIN plug-in module. 

• Fiery Bridge: Accessing scanned documents in your Integrated Fiery Color Server mailbox 
directly from a client Windows XP/Vista computer.

• Hot Folders: Storing and reusing frequently used print options when printing PostScript 
and PDF files on the Integrated Fiery Color Server.

• WebTools: Managing your Integrated Fiery Color Server remotely from the Internet or 
your company’s intranet.

For information about installing, configuring, and using ColorWise Pro Tools, see 
Color Printing. 

About Help

Detailed instructions on using most Integrated Fiery Color Server utilities are provided in 
Help. Wherever appropriate, this document refers you to Help for additional information and 
explains how to access Help for each utility. 
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Preparing for installation on Windows computers
Before installing Integrated Fiery Color Server software on a Windows computer, complete 
the following:

• To use Integrated Fiery Color Server user software on a Windows computer, the Sun Java 
file, Java Runtime Environment (JRE), provided in the Common Utilities folder on the 
User Software DVD, must be installed on your computer. If the correct Sun Java file is not 
installed, the Fiery User Software Installer installs it automatically before installing the 
Integrated Fiery Color Server software. 

NOTE: The recommended version of JRE, SE, is provided on the User Software 
DVD.

• To install the Integrated Fiery Color Server software, you must have Service Pack 4 
installed on a Windows 2000 computer, and Service Pack 2 installed on a Windows XP 
computer. If you do not, a warning message alerts you to install the Service Pack.

Different versions of Sun Java JRE can be installed on your computer. The Integrated Fiery 
Color Server software automatically finds the correct version, so you do not need to uninstall 
other versions of Sun Java JRE required for third-party applications.



INTRODUCTION 11
Preparing for installation on Mac OS computers
Before installing Integrated Fiery Color Server software on a Mac OS X computer, you can 
install printer fonts.

Fonts

The Fonts on the User Software DVD include screen and printer fonts that correspond to the 
136 built-in PostScript and True Type printer fonts on the Integrated Fiery Color Server. To 
be available to applications, the screen fonts must be installed on Mac OS X.

TO INSTALL SCREEN AND PRINTER FONTS ON MAC OS X V10.3 AND V10.4

1 Insert the User Software DVD into the DVD drive of the Mac OS X computer.

2 Start the Font Book application in Applications/Font Book.

3 Choose Add Fonts from the File menu.

4 Choose User Software/OSX/Fonts/Albertus MT.

5 Choose Select All from the Edit menu.

6 Choose one of the following from Install fonts:

• For your personal use: for your use only

• For shared use: for all users of this computer

• For Classic: for Mac OS X Classic

NOTE: For Mac OS X v10.4, you must select User, Computer, or Classic Mac OS in 
Preferences/Default Install Location of Font Book beforehand.

7 Click Open.

8 Exit the Font Book application.
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Installing user software
You can install Integrated Fiery Color Server user software in the following ways:

• From the User Software DVD

• From the Integrated Fiery Color Server, using the Internet or intranet

If you previously installed any Integrated Fiery Color Server user software on your computer, 
the installer allows you to uninstall those applications.

Installing user software on a Windows computer

All installation of user software on a Windows computer is done through the Fiery User 
Software Installer.  The procedures below describe installing from the DVD or over the 
Internet, and also modifying the user software.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive of your computer.

The installer Welcome screen appears.

2 Follow the on-screen instructions.

Do not attempt to install user software by opening the individual folders for the applications. 
Always use the Fiery User Software Installer.

To modify or remove any user software after you install it on your computer, use the User 
Software DVD and the following procedure.
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TO MODIFY USER SOFTWARE USING THE USER SOFTWARE DVD INSTALLER

1 Insert the User Software DVD into the DVD drive of your computer.

2 On the window that appears, select Modify, Repair, or Remove.

3 Follow the on-screen instructions.

If your computer does not have a DVD drive, you can install the user software from the 
Integrated Fiery Color Server over the network. Ask your network administrator for the IP 
address or DNS server name of the Integrated Fiery Color Server.

You can also install the Integrated Fiery Color Server user software over the Internet. Ask your 
network administrator for the IP address of the Integrated Fiery Color Server.

Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER OVER THE INTERNET 

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Integrated Fiery Color Server.

The Integrated Fiery Color Server home page appears. 

3 Click the Downloads tab.

4 Click the link for the software that you want to install.

5 Choose Run to open the file or Save to save it to your computer.

6 If you choose Run, proceed to step 9.

7 If you choose Save, browse to the location where you want to save the USERSWMI.exe file, 
and then click Save.

The file is downloaded from the Integrated Fiery Color Server.

8 Double-click the USERSWMI.exe file.

9 Choose to open the file or save it to your computer.

10 Type the Integrated Fiery Color Server URL, http://<IP address>, when prompted. 

11 Follow the on-screen instructions.

For complete instructions on how to use Downloads, see Downloads Help. 

For more information about WebTools and Downloads, see WebTools.

Do not attempt to install user software by opening the individual folders for the applications. 
Always use the Fiery User Software Installer.
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Installing user software on a Mac OS computer

Installation of user software on a Mac OS computer is done separately for each application. 

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive of your computer.

2 Browse to the OSX folder.

3 Double-click the installer icon for the application that you want to install.

4 Follow the on-screen instructions.

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER OVER THE INTERNET 

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Integrated Fiery Color Server.

The Integrated Fiery Color Server home page appears. 

3 Click the Downloads tab.

4 Click the link for Mac OSX Client Software Installer.

The osxutils.dmg file is downloaded to your computer and a virtual disk appears on your 
desktop.

5 Follow the on-screen instructions.

For complete instructions on using Downloads, see WebTools Downloads Help. 

For more information about WebTools and Downloads, see WebTools.
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Integrated Fiery Color Server digital press control panel
Various features are available from the Integrated Fiery Color Server digital press control panel 
by accessing pages from the following tabs:

• Main allows you to manage print connections.

• Info displays installed options on the Integrated Fiery Color Server and allows you to print 
system pages and activity logs. For more information, see Configuration and Setup.

Note: Digital press options are not shown.

• Scan allows you to edit scan templates. For more information, see “Scanning from the 
digital press” on page 43.

• Calibrate allows you to calibrate using ColorCal. For more information, see Color Printing.

• Setup accesses Setup options. For more information, see Configuration and Setup.

NOTE: The Integrated Fiery Color Server digital press control panel has a refresh rate of 2-3 
seconds.

Main page

The Main page displays Waiting, Held, Printed, and Secure Print job queues. If you are 
logged in as Administrator or Operator, you can print, print and hold, or delete jobs in the 
Waiting, Held, and Printed queues. You can also change the number of copies to be printed. 
The Secure Print job queues can be accessed by any user who has sent a Secure Print job from 
the printer driver. You can use the Suspend Printing feature on any job. 

For more information about Secure Print, see Printing from Windows and Printing from Mac 
OS. For more information about Suspend Printing, see Configuration and Setup. 

Procedures for accessing and using the features on the Main page are provided below.

TO ACCESS THE INTEGRATED FIERY COLOR SERVER DIGITAL PRESS CONTROL PANEL

1 Press the All Services icon at the upper-right corner of the digital press control panel.

2 Press Web Applications on the digital press control panel.

The Main page is displayed.

TO MANAGE PRINT QUEUES

1 On the Main page, click a tab to access the page for that tab.

2 To manage jobs in the Waiting, Held, and Printed pages, press Login on the digital press 
control panel and log in as Administrator or Operator.

3 To page through any of the queues, press the First, Prev, Next, and Last buttons on the digital 
press control panel.

4 To delete a job, press Delete on the digital press control panel for the job.
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5 To print a job, press Print on the digital press control panel for the job.

The Print page opens.

6 In the Print page, change the number of copies to be printed by typing the number in the 
Copies field.

7 Select Print, Print and Hold, or Cancel, as desired. 

8 Click More Info on the digital press control panel to open the Info page.

9 To interrupt the job that is currently printing, press Suspend Printing on the digital press 
control panel.

10 Press Resume Printing on the digital press control panel when you are ready to start the job 
again.
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COMMAND WORKSTATION, WINDOWS EDITION

Command WorkStation, Windows Edition allows Integrated Fiery Color Server operators (or 
users with Operator or Administrator privileges) to monitor and manage the print workflow 
of jobs on the Integrated Fiery Color Server. 

Command WorkStation, Windows Edition allows you to do the following:

• View the print status of jobs on the Integrated Fiery Color Server

• Hold, process, and print jobs

• Override user-assigned print option settings

• Preview the page content of a job

• Reorder pages in a job and combine pages from different jobs

• Create and use FreeForm master files for variable data printing

• Archive job files

• View job logs of recent print activity

• Define virtual printers

• Manage Fonts

Installing Command WorkStation, Windows Edition
Install Command WorkStation, Windows Edition on a Microsoft Windows computer 
that has a network connection to the Integrated Fiery Color Server. For a complete list of 
system requirements, see Welcome.

The installer for Command WorkStation, Windows Edition is provided on the User Software 
DVD. In addition to the Command WorkStation software, the installer installs the Java files 
required to use Fiery Setup from Command WorkStation. For information about using Fiery 
Setup, see Configuration and Setup.

NOTE: ColorWise Pro Tools is installed automatically when you install Command 
WorkStation. For information about using ColorWise Pro Tools, see Color Printing.

Before installing the utility, complete the preliminary procedures described in “Preparing for 
installation on Windows computers” on page 10.

To install Command WorkStation, Windows Edition, see “Installing user software on a 
Windows computer” on page 12.
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Configuring the connection to the Integrated Fiery Color Server
The first time you start Command WorkStation, you are prompted to configure the 
connection to the Integrated Fiery Color Server.

You can also edit the configuration whenever there is any change to your Integrated Fiery 
Color Server or network, such as a changed server name or IP address. If you change 
Integrated Fiery Color Server Setup information, do so before you reconfigure the 
connection. For information about reconfiguring the connection, see “To modify the 
configuration for Command WorkStation, Windows Edition” on page 20.

BEFORE YOU BEGIN

• Print the Integrated Fiery Color Server Configuration page. 

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information you need when configuring the connection, such as the 
IP address of the Integrated Fiery Color Server. For TCP/IP installations, you can use the 
DNS name instead of the IP address. Make sure that the Integrated Fiery Color Server is 
registered in a Domain Name Server (DNS) on your network. For more information, contact 
your network administrator. 

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION, WINDOWS EDITION

1 Choose Start  >  Programs  >  Fiery  >  Command WorkStation to start the utility.

The Available Servers dialog box appears and displays all servers found in the local subnet. 
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2 If no Integrated Fiery Color Servers are found, click the Manual tab to search by DNS name or 
IP address. Type the DNS name or IP address and click Add to add the server to the Available 
Servers list.

If no Integrated Fiery Color Servers are found by Manual search, click the Auto Search tab, and 
then click Advanced to search by a range of IP addresses or by the IP address and subnet 
mask. 

All available servers appear in the Available Servers list.

3 Select the Integrated Fiery Color Server that you want to use and click Add.

The selected Integrated Fiery Color Server is added to the Login Server window.
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4 Click the button to the left of the server name.

The Login dialog box appears.

5 Click the key to the left of Administrator, Operator, or Guest and type the appropriate 
password, if required.

6 Click Log In.

For information about setting passwords and the default Administrator password for the 
Integrated Fiery Color Server, see Configuration and Setup.

Command WorkStation is now connected to the Integrated Fiery Color Server.

TO MODIFY THE CONFIGURATION FOR COMMAND WORKSTATION, WINDOWS EDITION

1 Start Command WorkStation.

The Login Server window appears.

2 Select the Integrated Fiery Color Server for which you want to modify the configuration and 
click Remove.

3 Repeat “To configure the connection for Command WorkStation, Windows Edition” on 
page 18.
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Using Command WorkStation, Windows Edition
After you install and configure Command WorkStation, you can begin using it to monitor 
and manage jobs on the Integrated Fiery Color Server. 

For complete instructions on using the standard Command WorkStation features, see 
Command WorkStation Help. Additional features are described in the sections starting on 
page 22. 

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the Integrated Fiery Color Server from the Server List dialog box and log on to the 
server.

For information about setting passwords and the default Administrator password for the 
Integrated Fiery Color Server, see Configuration and Setup. 

2 Choose Help from the Help menu.
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Additional features
The following sections describe how to use additional features of Command WorkStation that 
are not discussed in Command WorkStation Help.

User Authentication

If user authentication is enabled in Integrated Fiery Color Server Setup, users may need to 
type a user name and password in the printer driver to send a job to the Integrated Fiery 
Color Server. Management of the job in Command WorkStation is determined by how you 
log on to the Integrated Fiery Color Server (as Administrator, Operator, or Guest).

For information about setting up Users and Groups and enabling user authentication in the 
Configure WebTool, see Configuration and Setup. For information about User Authentication 
in the printer driver, see Print Options.

Align Trays

The Align Trays feature allows you to adjust the placement of text and images on the page 
so that they are correctly aligned on a sheet of paper. This ensures that both sides of a duplex 
sheet have exactly the same alignment.

You can also perform tray alignment from the Integrated Fiery Color Server digital press 
control panel by choosing Tray Alignment from the Functions menu.

To perform tray alignment, you must do the following:

• Log on to the Integrated Fiery Color Server with Administrator privileges and enable tray 
alignment in Integrated Fiery Color Server Setup.

• Enable Tray Alignment in the Media area of the printer driver.

• Select the correct paper tray before printing.

NOTE: For Tray Alignment to work when printing a job, select the tray that you have aligned 
in the Paper Source option bar before printing. If you later print a job using the auto tray 
selection, the alignment does not work. 

TO ALIGN PAGES FOR PRINTING

1 In the Active Jobs window, select the connected Integrated Fiery Color Server for which you 
want to perform tray alignment.

If the Active Jobs window is hidden, choose Active Jobs from the Window menu to display it.

2 Choose Align Trays from the Server menu.
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A dialog box containing the Tray Alignment options appears.

3 Choose the tray that you want to align from the Tray menu.

4 Choose the paper size loaded in the tray from the Media menu.

NOTE: The alignment is specific to the combination of tray and paper size specified. If you 
align a given tray with Letter paper, and then load Legal paper in that tray, the alignment is 
wrong. You must perform a new alignment for each combination of tray and paper size.

5 In the Print Alignment Page area, select the Print Duplex option to print a duplex page, or 
clear the option to print a simplex page.

6 Click Print.

7 After the Alignment Page is printed, follow the instructions on the page. 

Fold the page exactly in half horizontally, unfold it, and then fold it in half vertically. When 
you unfold the sheet, observe that the fold lines cross three scales on three sides of the page. 
Determine which number on the scale each fold line crosses.

8 In the Enter alignment values area, enter the value that appears where the fold crosses each 
of the three scales, marked A, B, and C, for Side 1. If you choose to align for duplex printing, 
enter the values for the three scales on Side 2 of the page, as well.

NOTE: If you enter different values in A and C, the image rotates, leading to uneven areas on 
printed output. If this occurs, enter the same value in A and C.

9 After you enter the alignment values, click Apply, and then click Check Alignment to print 
the new alignment page. 

10 To remove the alignments, select a tray and click Defaults in the Enter alignment values area.

11 Click Done.
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Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of 
pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with 
any media, page size, or finishing settings that have been specified for the job in the 
Job Properties dialog box or printer driver. 

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media 
dialog box highlights the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after 
specifying Mixed Media settings, certain print options may conflict with the page-specific 
Mixed Media settings. You must resolve the conflict by choosing different print options or 
removing certain Mixed Media specifications.

• Mixed Media settings affect the use of output color profiles when the “Use media defined 
profile” option is selected in ColorWise Pro Tools. For more information, see Color 
Printing.

• If counters are configured for the digital press, blank media inserted between pages count 
as printed pages.

Basic instructions for accessing and using Mixed Media are provided in Command 
WorkStation Help. Features specific to the Integrated Fiery Color Server are described in the 
following procedures.
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TO DEFINE MIXED MEDIA SPECIFICATIONS

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from 
the Actions menu, or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

The Mixed Media dialog box lists any previously defined media settings and includes buttons 
for defining, modifying, and removing settings.

3 For Chapter Start Page(s), type the page numbers on which you want to start new chapter 
sections.

Type page numbers as comma-separated values (for example: 4,9,17) to designate the start 
of each new chapter. This feature forces each starting page to use a right-side page, adding 
a preceding left-sided blank, if required. 

NOTE: It is not necessary to type the first page, and page numbers refer to the numbering of 
the original document. If you use the Chapter Start Page(s) feature, all media specified in the 
Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, 
or all A4).

4 To apply finishing options (for example, stapling or sorting) to each chapter created using 
the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” 
option.

NOTE: Not all finishing options can be applied to chapters that contain mixed sizes of media 
(for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover. 

For more information, see “To define cover media settings” on page 26.

6 To define properties for individual pages or page ranges, click New Page Range.

For more information, see “To define media for specific pages” on page 27.

7 To insert blank pages, click New Insert.

For more information, see “To insert blank pages” on page 27.
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8 To modify or delete a current definition, select it in the Mixed Media Definition list, and then 
click Edit or Remove.

If you click Edit, enter new settings for the definition and click Modify.

9 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box 
and Job Properties.

The Mixed Media settings are applied to the job.

NOTE: You can save up to 100 different settings for the Selection list in the Mixed Media 
dialog box.

TO DEFINE COVER MEDIA SETTINGS

1 In the Mixed Media dialog box, click Define Cover.

The Cover Media dialog box appears.

2 To define identical front cover and back cover media, select the “Apply the same settings 
for both front and back cover” option. To define media settings for the front or back cover 
individually, select the Front Cover or Back Cover option.

3 Choose other settings, as required, from the pull-down menus.

4 Click OK to return to the Mixed Media dialog box.

Cover Media settings override settings defined in the Page/Page Range Media dialog box.
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TO DEFINE MEDIA FOR SPECIFIC PAGES

1 In the Mixed Media dialog box, click New Page Range.

The Page/Page Range Media dialog box appears.

2 Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3 Choose other settings, as required, from the pull-down menus.

If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to 
force the assigned page content to the front side of the next sheet.

4 Click Add Definition after each media setting that you define. 

5 Click Close to return to the Mixed Media dialog box.

TO INSERT BLANK PAGES

1 Click New Insert in the Mixed Media dialog box.

The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target page as 
the first page in the document, the last page in the document, or a specific numbered page.

3 Choose other settings, as required, from the pull-down menus.
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4 Click Insert after each blank page that you define.

5 Click Close to return to the Mixed Media dialog box.

Virtual Printers

Virtual printers offer users a method of printing to the Integrated Fiery Color Server using 
predefined settings to configure the print job. The Integrated Fiery Color Server 
administrator can create virtual printers and publish them so that users can access them on the 
network. SMB, LPR and FTP services are supported. You can also access virtual printers 
through the File > Import function in Command WorkStation and through the USB Media 
Server. For more information about USB Media Server and printing from a USB device, see 
Printing from Windows.

NOTE: By default, three virtual printers are already set up to correspond to the print queue, 
hold queue, and direct connection. These virtual printers cannot be modified.

The administrator specifies job settings for the virtual printer. The administrator can apply an 
imposition template to a virtual printer. Imposition settings override job property settings.

The Integrated Fiery Color Server administrator can view the available virtual printers and 
published queues, publish a virtual printer, and delete, duplicate, or edit a virtual printer.

You must log on with Administrator privileges to configure virtual printers.

TO CONFIGURE A VIRTUAL PRINTER

1 Choose Virtual Printers from the Command WorkStation Server menu.

2 Click New.

3 Specify the following:

• Virtual Printer Name: Type an alphanumeric name.

• Comments: Add comments to help define the virtual printer for the user, for example, 
“duplex company brochure”.

• Printing: Select one of the standard Integrated Fiery Color Server actions available from 
Command WorkStation, including Hold, Process and Hold, Print, or Print and Hold.

• Use Custom Job Properties: Access and choose Job Properties.

• Apply Imposition Settings: Access and choose Impose settings.

NOTE: Only users with access to printer drivers with the Two-Way Communication feature 
enabled can see and override the job settings.

4 Click OK.
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TO MANAGE VIRTUAL PRINTERS

1 Choose Server > Virtual Printers.

2 Select a virtual printer in the list and click Edit, Duplicate, or Delete.

NOTE: After a virtual printer is created, its name cannot be changed, although the print 
settings can be changed.

Printing to a virtual printer using SMB

Virtual printers are published on the network. To print to a published virtual printer from a 
client computer over SMB, do the following:

TO PRINT TO A VIRTUAL PRINTER USING SMB

1 Right-click Network Neighborhood or My Network Places, and select Find Computer or Search 
for Computers.

2 Type the name of the Integrated Fiery Color Server that you are looking for and click Search 
Now.

If you cannot locate the Integrated Fiery Color Server, contact your network administrator.

3 Double-click the name of the Integrated Fiery Color Server to display published virtual 
printers.

4 Double-click the virtual printer that you want to connect to.

You must install the printer driver from the User Software DVD as described in Printing from 
Windows.

The virtual printer appears in Settings > Printers and Faxes.

Printing to a virtual printer using LPR on Windows
To print to a virtual printer from a client computer using an LPR connection on Windows, 
you must configure a standard TCP/IP port for LPR printing and install the Integrated Fiery 
Color Server printer drivers. When you configure the port, select LPR for the protocol and 
type the name of the virtual printer for the queue name.

For information, see Printing from Windows. 
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Printing to a virtual printer using LPR on Mac OS
To print to a virtual printer from a client computer using an LPR connection on Mac OS, 
follow the instructions for setting up the Integrated Fiery Color Server on Mac OS X using IP 
printing. For Queue Name, enter the name of the virtual printer.

For information, see Printing from Mac OS. 

Printing to a virtual printer using FTP

If enabled in Server Setup, the Integrated Fiery Color Server can function as an FTP server. 
For information about setup, see Configuration and Setup. 

To print to a virtual printer using FTP, use your FTP client software and connect to the 
Integrated Fiery Color Server as to any FTP server. Ask your network administrator for the 
following information:

• IP address or DNS name of the Integrated Fiery Color Server

• User name and password, if required

• Name of the virtual printer

For more information about FTP printing, see Printing from Windows and Printing from 
Mac OS.
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Troubleshooting
When troubleshooting basic connection and software problems with Command 
WorkStation, see the following sections. For additional troubleshooting information, see 
Command WorkStation Help.

Command WorkStation cannot connect to the Integrated Fiery 
Color Server

If you cannot connect to the Integrated Fiery Color Server or locate the Integrated Fiery 
Color Server from your computer, contact the network administrator. The administrator may 
need to troubleshoot your network connections and check settings on the servers that you 
print to. If settings have changed, it may be necessary to reconfigure the Integrated Fiery 
Color Server (see Configuration and Setup).

If you can connect to the Integrated Fiery Color Server with another utility, you may need to 
reconfigure the Command WorkStation connection to the Integrated Fiery Color Server (see 
page 18).

If you configured the Integrated Fiery Color Server and set up client computers and network 
servers according to the instructions in Configuration and Setup, print a Test Page. If you can 
print a Test Page but still cannot print a document from a remote computer, contact your 
network administrator to troubleshoot the network connection.

If you cannot connect and cannot print a Test Page, check the digital press control panel for 
error information.

Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

IF THE COMMAND WORKSTATION WINDOWS DO NOT UPDATE

1 Log off and then quit Command WorkStation. 

2 Restart Command WorkStation or restart the computer. 

If the Command WorkStation windows do not update or no jobs are displayed, and the 
mouse has no effect (you cannot select a job or a window, use a right mouse command, or 
select a menu item), the Integrated Fiery Color Server is offline or network communication 
has failed.

TO FORCE AN EXIT FROM COMMAND WORKSTATION

1 Press Ctrl-Alt-Delete and use the Program Manager to close Command WorkStation. 

2 At the Integrated Fiery Color Server, disconnect and reconnect the network cable, and then 
try printing a Test Page or Configuration page.

3 If printing fails, restart the Integrated Fiery Color Server.
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COMMAND WORKSTATION, MACINTOSH EDITION

Command WorkStation, Macintosh Edition allows Integrated Fiery Color Server 
operators (or users with Operator or Administrator privileges) to monitor and manage the 
print workflow of jobs on the Integrated Fiery Color Server. 

Command WorkStation, Macintosh Edition, enables you to do the following:

• View the print status of jobs on the Integrated Fiery Color Server

• Hold, process, and print jobs

• Override user-assigned print option settings

• Preview the page content of a job

• Create and use FreeForm master files for variable data printing

• Archive job files

• View Job Logs of recent print activity

Installing Command WorkStation, Macintosh Edition
Install Command WorkStation, Macintosh Edition on a Mac OS X computer that has 
a network connection to the Integrated Fiery Color Server. For complete system 
requirements, see Welcome.

Before installing the utility, complete the preliminary procedures described in “Preparing for 
installation on Mac OS computers” on page 11.

To install Command WorkStation, Macintosh Edition, see “Installing user software on a Mac 
OS computer” on page 14.

Configuring the connection to the Integrated Fiery Color Server
The first time you start Command WorkStation, you are prompted to configure the 
connection to the Integrated Fiery Color Server.

You can also edit the configuration whenever there is any change to your Integrated Fiery 
Color Server server or network, such as a changed server name or IP address. If you change 
Integrated Fiery Color Server Setup information, do so before you reconfigure the 
connection.
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BEFORE YOU BEGIN

• Print the Integrated Fiery Color Server Configuration page. 

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information that you need when configuring the connection, such as the 
IP address of the Integrated Fiery Color Server. For TCP/IP installations, you can use the 
DNS name instead of the IP address. Make sure that the Integrated Fiery Color Server is 
registered in a Domain Name Server (DNS) on your network. For more information, see the 
documentation that accompanies your network system. 

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION, MACINTOSH EDITION

1 Open the Applications  :  Fiery  :  CWS Macintosh Edition folder on the Mac OS X hard disk. 
Double-click the CWS Macintosh Edition file to start the application.

The Available Servers dialog box appears, displaying all servers found in the local subnet.

2 If no Integrated Fiery Color Servers were found, click the Manual tab to search by DNS name 
or IP address. Click Add to add the server to the Available Servers list.
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If no Integrated Fiery Color Servers were found in the Manual search, click the Auto Search 
tab, and then click Advanced to search by a range of IP addresses or the IP address and 
subnet mask. 

All available servers are displayed in the Available Servers list.

3 Select the Integrated Fiery Color Server that you want to use and click Add.

The selected Integrated Fiery Color Server is displayed in the Server List dialog box.

4 Click the server name to select it, and then click the key icon or Login button.

The Login dialog box appears.

5 Click administrator, operator, or guest, type the password in the field next to the key, and 
then click Login.

Your computer is connected to the server.

For more information about setting passwords and the default Administrator password for the 
Integrated Fiery Color Server, see Configuration and Setup.

To modify the Command WorkStation connection to the Integrated Fiery Color Server, you 
must remove the server from the Login Server list and follow the procedure for configuring 
the connection.
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Using Command WorkStation, Macintosh Edition
After you install and configure Command WorkStation, you can begin using it to monitor 
and manage jobs on the Integrated Fiery Color Server. 

Complete instructions on how to use the Command WorkStation features are provided in 
Command WorkStation Help. 

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the Integrated Fiery Color Server in the server list and log on to the server.

For more information about setting passwords and the default Administrator password 
for the Integrated Fiery Color Server, see Configuration and Setup.

2 Choose Help from the CWS menu.
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Additional features
The following sections describe how to use additional features of Command WorkStation that 
are not discussed in Command WorkStation Help.

User Authentication

If user authentication is enabled in Integrated Fiery Color Server Setup, users may need to 
type a user name and password in the printer driver to send a job to the Integrated Fiery Color 
Server. Management of the job in Command WorkStation is determined by how you log on 
to the Integrated Fiery Color Server (as Administrator, Operator, or Guest).

For information about setting up Users and Groups and enabling user authentication in 
the Configure WebTool, see Configuration and Setup. For information about User 
Authentication in the printer driver, see Print Options.

Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of 
pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with any 
media, page size, or finishing settings that have been specified for the job in the Job 
Properties dialog box or printer driver.

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media 
dialog box highlights the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after 
specifying Mixed Media settings, certain print options may conflict with the page-specific 
Mixed Media settings. You must resolve the conflict by choosing different print options or 
removing certain Mixed Media specifications.

• If counters are configured for the digital press, blank media inserted between pages count 
as printed pages.

Features specific to the Integrated Fiery Color Server are described in the following 
procedures.

NOTE: The procedures for defining Mixed Media settings in Command WorkStation, 
Windows Edition are similar to those in Command WorkStation, Macintosh Edition, 
but include illustrations. For information, see page 24.
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TO DEFINE MIXED MEDIA SPECIFICATIONS

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from 
the Actions menu, or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

The Mixed Media dialog box lists any previously defined media settings and includes buttons 
for defining, modifying, and removing settings.

3 For Chapter Start Page(s), type the page numbers on which you want to start new chapter 
sections.

Type page numbers as comma-separated values (for example: 4,9,17) to designate the start 
of each new chapter. This feature forces each starting page to the right side, adding a 
preceding left-sided blank, if required. 

NOTE: It is not necessary to type the first page. Page numbers refer to the numbering of the 
original document. If you use the Chapter Start Page(s) feature, all media specified in the 
Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, 
or all A4).

4 To apply finishing options (for example, stapling or sorting) to each chapter created using 
the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” 
option.

NOTE: Not all finishing options can be applied to chapters that contain mixed sizes of media 
(for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover. 

For more information, see “To define cover media settings” on page 38.

6 To define properties for individual pages or page ranges, click New Page Range.

For more information, see “To define media for specific pages” on page 38.

7 To insert blank pages, click New Insert.

For more information, see “To insert blank pages” on page 38.

8 To modify or delete a current definition, select it in the Mixed Media Definition list, and then 
click Edit or Remove.

If you click Edit, enter new settings for the definition and click Modify.

9 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box 
and Job Properties.

The Mixed Media settings are applied to the job.

NOTE: You can save up to 100 different settings for the Selection list in the Mixed Media 
dialog box.
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TO DEFINE COVER MEDIA SETTINGS

1 In the Mixed Media dialog box, click Define Cover.

The Cover Media dialog box appears.

2 To define identical front cover and back cover media, select the “Apply the same settings 
for both front and back cover” option. To define media settings for the front or back cover 
individually, select the Front Cover or Back Cover option.

3 Specify other settings, as required.

4 For Cover Page Mode, define how you want the content printed on the cover. You can 
specify printing on the front side only, back side only, or both sides of the cover page.

5 Click OK to return to the Mixed Media dialog box.

Cover Media settings override settings defined in the Page/Page Range Media dialog box.

TO DEFINE MEDIA FOR SPECIFIC PAGES

1 Click New Page Range in the Mixed Media dialog box.

The Page/Page Range Media dialog box appears.

2 Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3 Specify other settings, as required.

If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to 
force the assigned page content to the front side of the next sheet.

4 Click Add Definition after each media setting that you define. 

5 Click Close to return to the Mixed Media dialog box.

TO INSERT BLANK PAGES

1 Click New Insert in the Mixed Media dialog box.

The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target 
page as the first page in the document, the last page in the document, or a specific 
numbered page.

3 Specify other settings, as required, for the blank page.

4 Click Insert after each blank page that you define.

5 Click Close to return to the Mixed Media dialog box.
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Troubleshooting
When troubleshooting basic connection and software problems with Command 
WorkStation, see the following sections. For additional troubleshooting information, see 
Command WorkStation Help.

Command WorkStation cannot connect to the Integrated Fiery 
Color Server

If you cannot connect to the Integrated Fiery Color Server or locate the Integrated Fiery 
Color Server from your computer, contact the network administrator. The administrator may 
need to troubleshoot your network connection and check settings on the servers that you 
print to. If settings have changed, it may be necessary to reconfigure the Integrated Fiery 
Color Server.

If you can connect to the Integrated Fiery Color Server with another utility, you may need to 
reconfigure the Command WorkStation connection to the Integrated Fiery Color Server (see 
page 32).

If you configured the Integrated Fiery Color Server and set up client computers and network 
servers according to the instructions in Configuration and Setup, print a Test Page. If you can 
print a Test Page, but still cannot print a document from a remote computer, contact your 
network administrator to troubleshoot the network connection.

Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

IF THE COMMAND WORKSTATION WINDOWS DO NOT UPDATE

1 Log off and then quit Command WorkStation. 

2 Restart Command WorkStation or restart the computer. 

If the Command WorkStation windows do not update, or no jobs are displayed, and the 
mouse has no effect (you cannot select a job or a window, use a Control-click command, or 
select a menu item), the Integrated Fiery Color Server is offline or network communication 
has failed.

TO FORCE AN EXIT FROM COMMAND WORKSTATION

1 Press Command-Option-Escape and use the Force Quit Applications dialog box to close 
Command WorkStation. 

2 At the Integrated Fiery Color Server, disconnect and reconnect the network cable, and then 
try printing a Test Page or Configuration page.

3 If printing fails, restart the Integrated Fiery Color Server.
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SCAN

Scan is a collection of software components that allow you to scan documents from the digital 
press glass or through the digital press’s automatic document feeder (ADF) and send the 
scanned images to specific destinations. Scan consists of the following components:

• Remote Scan includes the TWAIN plug-in module. Remote Scan allows you to remotely 
retrieve a scan from a digital press.

• Scan to E-mail allows you to send the scan file by e-mail as either an attachment or URL.

• Scan to FTP allows you to send the scan file to an FTP server.

• Scan to Internet Fax allows you to send the scan file to an e-mail address to be delivered as 
a fax.

• Scan to Mailbox allows you to send the scan to a mailbox on the Integrated Fiery Color 
Server, from where it can be retrieved.

• Scan to Hold queue allows you to scan to the Integrated Fiery Color Server Hold queue for 
document merging and editing.

• Docs WebTool allows you to retrieve scanned jobs from mailboxes on the Integrated Fiery 
Color Server.
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Installing and configuring Remote Scan
The following sections describe how to install and configure Remote Scan. After you have 
connected to the Integrated Fiery Color Server, you can access Help from Remote Scan.

Installing Remote Scan

To install and use the Remote Scan application and TWAIN plug-in module, you must have a 
Windows or Mac OS computer with a network connection. For detailed system 
requirements, see Welcome.

The installer for Remote Scan is located on the User Software DVD.

To install Remote Scan, see “Installing user software on a Windows computer” on page 12 
and “Installing user software on a Mac OS computer” on page 14.

Configuring Remote Scan

The first time you start Remote Scan, you must configure the connection to the Integrated 
Fiery Color Server. Before you configure the connection, you must have the correct IP 
address. Make sure that the Integrated Fiery Color Server is registered in a Domain Name 
Server (DNS) on your network. When you open Remote Scan, the Scan Configuration dialog 
box appears. For instructions on configuring the connection to the Integrated Fiery Color 
Server for the first time, see “To configure the connection to the Integrated Fiery Color 
Server” on page 42.

Complete instructions on configuring and modifying the connection to the Integrated Fiery 
Color Server are provided in Remote Scan Help.

If you have previously configured a connection to the Integrated Fiery Color Server, it appears 
in the main Remote Scan window, and you can immediately start to initiate a scan or retrieve 
any scans initiated at the digital press control panel, and use Remote Scan Help.
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TO CONFIGURE THE CONNECTION TO THE INTEGRATED FIERY COLOR SERVER

1 When you start Remote Scan for first-time use, the Configuration window automatically 
appears. In the Server Name (or IP Address) text field, type the IP address or DNS name of 
the Print Server.

2 Select Use Nickname to enter another name to distinguish the Integrated Fiery Color Server. 
This name does not have to match the actual Server Name of the Integrated Fiery Color 
Server.

3 Type the name of the device connected to the Integrated Fiery Color Server. 

You can assign any name for the device name.

4 Click the green arrow to add the Integrated Fiery Color Server to My Fiery List. 

5 Click OK.

TO ACCESS REMOTE SCAN HELP

1 Start Remote Scan or open the Remote Scan plug-in module.

2 Connect to the Integrated Fiery Color Server that has already been configured.

3 Click the Help button.

4 Use the Contents, Index, or Search panes to navigate to the Remote Scan Help topics.

Using Remote Scan
With Fiery Remote Scan and the TWAIN plug-in module, you can retrieve scan files 
remotely by accessing a mailbox, which is set up in the Users and Groups section of WebTools 
Configure. You can open the scan file in a host application, such as Adobe Photoshop, and 
send the scan file to a mailbox, the Hold queue, or an e-mail address. All scans are stored on 
the Integrated Fiery Color Server hard disk and retrieved through the network.

Complete instructions on using Remote Scan and the TWAIN plug-in module are provided 
in Remote Scan Help. Although instructions are provided in Help for initiating scans from 
Remote Scan, this feature is not supported for the Integrated Fiery Color Server. Scanning is 
initiated at the digital press control panel. For more information, see the following section.
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Scanning from the digital press
Scan jobs are initiated at the digital press control panel and either stored in a mailbox on the 
Integrated Fiery Color Server for remote retrieval or sent from the Integrated Fiery Color 
Server using e-mail, Internet Fax, FTP, or SMB. Scan jobs can be retrieved from a mailbox 
using the Docs WebTool or the Remote Scan application.

The Integrated Fiery Color Server uses Scan Settings, or scan templates, to determine how to 
scan a document and where to send it. Each scan template is listed in the Network Scanning 
area of the digital press control panel. To scan a document, you must use one of the scan 
templates listed at the digital press control panel. A number of default scan templates are 
provided with the Integrated Fiery Color Server. You can modify a duplicated scan template 
at the digital press control panel, or create a new scan template in WebTools Scan Settings.

Scanning workflows

Any user can initiate a scan at the digital press by choosing one of the default scan templates 
listed in the Network Scanning area of the digital press control panel. The scan can then be 
retrieved from the “guest” mailbox using WebTools Docs or the Remote Scan application. 
Several default scan templates are available, some of which are locked and some of which are 
editable. For more information, see “Default Scan Settings” on page 44.

You can specify a different destination for a default editable scan template in the Scan tab of 
the Web Applications area of the digital press control panel, and save it as a new scan 
template. You can then select this new scan template from the list in the Network Scanning 
area of the digital press control panel. For more information, see “Modifying Scan Settings at 
the digital press” on page 46.

The Integrated Fiery Color Server administrator can create in WebTools Scan Settings a 
custom scan template that other users cannot edit. The administrator can assign ownership of 
this new scan template to an existing user. Either the administrator or the user who owns the 
scan template can define the document settings and destinations for it. It can then be selected 
from the list in the Network Scanning area of the digital press control panel. 

Mailboxes for scan jobs are set up in WebTools Configure Users and Groups by the 
administrator. The administrator belongs to the “admin” group. Guest and Operator are also 
default groups on the Integrated Fiery Color Server. A mailbox is set up by adding user names 
to a group with Fiery Mailbox Privileges. The administrator can also add users from an LDAP 
address book. Administrators can view and manage all Scan Settings templates, including 
deleting templates, and changing the user name/mailbox for a specific Scan Settings template. 
Administrators can also view all mailboxes in WebTools Docs and manage the scans sent to 
mailboxes.

NOTE: To log in as Administrator to WebTools Docs and Scan Settings, you must type the 
user name as “admin”.
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Default Scan Settings

To initiate a scan from the digital press control panel, choose a scan settings template. The 
Integrated Fiery Color Server comes with several default scan settings templates that you can 
select at the digital press control panel. 

Default locked templates that cannot be changed are:

• (ColorCal): for calibrating the Integrated Fiery Color Server

• (bw): for black-and-white documents

• (color): for color documents

• (grayscale): for grayscale documents, such as black-and-white photographs

Default guest templates that can be edited are:

• COLOR0GUEST

• GRAYSCALE0GUEST

• BW0GUEST

You can create a new template based on one of the default guest templates by renaming it and 
modifying it at the digital press or by modifying it in WebTools Scan Settings. You can change 
the destinations either at the digital press or in WebTools Scan Settings. You can modify 
document settings in WebTools Scan Settings. 

NOTE: You cannot change the color mode setting when you are creating a scan template based 
on either one of the Integrated Fiery Color Server default guest templates or on a template 
you created in WebTools Scan Settings.

For information about setting up scan templates, see WebTools Scan Settings Help and 
“Modifying Scan Settings in WebTools” on page 48.

For information about setting up users and mailboxes, see WebTools Configure Help.
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Scanning with default scan settings

When you initiate a scan from the digital press, you select a scan settings template from the 
list displayed on the digital press control panel. 

TO SCAN A DOCUMENT FROM THE DIGITAL PRESS

1 Press the All Services icon at the upper-right corner of the digital press control panel.

2 Press Network Scanning.

3 Select the template that you want to use. 

All Scan Settings templates are displayed.

4 If desired, select options in the General Settings pane, and also in the Image Quality, Layout 
Adjustment, and Output Format panes.

NOTE: You cannot change color mode settings for any of the default templates or templates 
created from them.

When you select options in the Image Quality, Layout Adjustment, and Output Format 
panes, you must click Save. Any document settings selected at the digital press control panel 
before scanning a document are only saved and applied for the scan you are performing. After 
the scan is completed, the settings revert to the original settings for that scan template.

For more information about document settings on the digital press, see the documentation 
that accompanies your digital press.

5 Press the green Start button on the front of the digital press.

6 To retrieve your scan, use Remote Scan or WebTools Docs.

NOTE: The default mailbox for all default Scan Settings is guest.
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Modifying Scan Settings at the digital press

All users can modify the guest-owned scan settings at the digital press. When you choose a 
scan template in the Web Applications area of the digital press control panel, you can rename 
the template to create a new template, and then edit any of the scan settings’ destinations.

When you use a default template as a basis for creating a new template, you cannot change the 
scan color of the original template. So you should choose the template to use as your basis by 
the color: color, black-and-white, or grayscale.

TO MODIFY A SCAN TEMPLATE ON THE DIGITAL PRESS CONTROL PANEL

1 Press the All Services icon at the upper-right corner of the digital press control panel.

2 Press Web Applications.

3 Press the Scan tab.

NOTE: Only the guest-owned scan settings are displayed. “Guest-owned” means that they have 
been created under the user name of “guest”, and the scans are sent to the guest mailbox.

4 If you want to change the destination mailbox for one of the guest-owned scan settings, you 
must log in as Administrator. 

To do so, click Login, select Administrator, and type the Administrator password.

5 Select a scan settings template.

6 To view the destination settings for a scan template, press the two arrows to the left of the 
scan template name. 

The scan destinations designated for that template are displayed.

7 To view the document settings for the template, press the arrow at the top right of the 
window.

The Document Settings are displayed.

8 Click OK to return to the Scan Templates page.

9 To create a scan template, press the Edit button for the template that you want to use as the 
basis.

10 Type a new name in the Name field for the Scan Settings.

The user name for all scan templates displayed in Web Applications on the digital press 
control panel is guest and cannot be changed by users with guest access. If you log in as 
Administrator, you can change the user name. As the Administrator, you can also change the 
user name in WebTools Scan Settings.

NOTE: The new scan template name must consist only of uppercase letters and numbers. 
Lowercase letters and special characters are not allowed.

11 If desired, type a description in the Description field.
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12 Select one of the following destinations:

• Mailbox allows you to send the scan file to a Mailbox that you select in WebTools Scan 
Settings. You must set up the Mailbox first as a user of a group in WebTools Configure 
Users and Groups that has mailbox privileges. The default mailboxes are: admin, operator, 
and guest.

• E-mail allows you to send the scan file via e-mail. In Setup, the administrator determines 
the maximum allowed size of the attachment. If the attachment size exceeds this 
maximum, the Integrated Fiery Color Server sends it as a URL. For more information, see 
Configuration and Setup.

• Internet Fax allows you to send the scan file by e-mail via a fax server to an analog fax 
machine. The scan is converted to Internet Fax format. When you send a scan to Internet 
Fax, type the address in e-mail format. 

• FTP allows you to send the scan file to an FTP site. If a Proxy Server has been enabled by 
the Integrated Fiery Color Server administrator in Setup, ask the administrator for the 
Proxy Address. You may be required to type a user name and password. If the user name is 
displayed as blank, an anonymous login is allowed, and you do not have to type a 
password.

• SMB allows you to send the scan file to any network folder or computer on the network 
using SMB. You must know the domain, the computer name (server name), and the 
shared folder for the destination computer to send a file using SMB. You are required to 
type a user name and password. If a password is required, but not entered, no error 
message is displayed, and the scan file is not sent to the destination. It may be that a 
password was not required. Check with your network administrator for the login 
requirements for any SMB connection on your network. 

13 Press Save Changes.

The new scan template you have just created appears in the list of templates.

14 Press the All Services icon at the upper-right corner of the digital press control panel.

After you have created your new template on the digital press control panel, you can specify 
document settings on the digital press control panel and initiate the scan.
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Modifying Scan Settings in WebTools

When you log into Scan Settings you can view all scan templates associated with your user 
name. You must have Integrated Fiery Color Server mailbox privileges and can only modify 
scan template files to which you have access.

The administrator has full access to all scan templates. In addition, the administrator can 
create new scan templates in Scan Settings and can import and export scan templates. The 
procedure below is for all users.

TO MODIFY SCAN SETTINGS IN WEBTOOLS

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Integrated Fiery Color Server.

3 Click the Scan Settings tab.

4 Log in to Scan Settings.

To log in as guest, you do not need to type a password. To log in as an Administrator, you 
must type “admin” in the User Name field and type the Administrator password, if required.

5 Select the scan template that you want to edit and click Edit.

6 Specify the following General Setting options for your scan template:

• Name: Specify the name to display on the digital press control panel and in the list of Scan 
Settings. The name must be numbers and/or all-capital letters, and must contain no 
special characters.

• Description: Type a description of your scan template to allow users to identify the scan 
template at the print engine scan initiation screen.

• Username: Specify the owner name of the scan template. When you log in to Scan 
Settings, only scan templates display that match your user name and your login user name. 

This option can only be edited by an administrator. The administrator can specify any 
Integrated Fiery Color Server user that has mailbox rights (including local Integrated Fiery 
Color Server users, LDAP users, and members of LDAP groups that have mailbox 
privileges). 

7 Specify Scan Destination options for your scan template.

8 Specify Document Settings options for your scan template.

9 Specify Scan Enhancement options for your scan template.

10 To save your scan template, click Save.

At least one scan destination must be specified to save the scan template.

11 To cancel your changes and return to the main Scan Settings window, click Cancel.

12 To revert changes you have made to the scan template, click Reset.
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Creating Scan Settings in WebTools

Scan Settings allows users with administrator access to create new scan templates in Scan 
Settings, in addition to editing scan templates. Administrators can also delete scan templates 
and change user names for a scan settings template.

TO CREATE A NEW SCAN TEMPLATE IN WEBTOOLS

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Integrated Fiery Color Server.

3 Click the Scan Settings tab.

4 Log in to Scan Settings.

To log in as an Administrator, you must type “admin” in the User Name field and type the 
Administrator password, if required.

5 Click the New icon.

6 Specify the settings for your scan template.

7 To save your scan settings, click Save.

Retrieving scans

You can retrieve scans from a mailbox using WebTools Docs or Remote Scan. For information 
about Remote Scan, see “Using Remote Scan” on page 42. For information about using 
WebTools, see page 58.
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FIERY BRIDGE

Fiery Bridge is an application that allows you to access scanned documents in your Fiery 
mailbox directly from a client Windows XP computer.

Fiery Bridge makes your mailbox accessible as if it were a standard network drive, allowing 
you to browse its contents using Windows. You can open a scanned document from an 
appropriate application on your computer, just as you would open any file on your computer.

Fiery Bridge is an alternative to transferring scanned documents from a Fiery using Remote 
Scan or WebTools and can simplify your scanning workflow. You can even use Fiery Bridge in 
combination with Hot Folders to create an automated workflow. 

Installing Fiery Bridge
Install Fiery Bridge on a Windows XP computer that has a network connection to the 
Integrated Fiery Color Server. For a complete list of system requirements, see Welcome.

The installer for Fiery Bridge is provided on the User Software DVD. 

Before you install the utility, read the guidelines described in “Preparing for installation on 
Windows computers” on page 10.

To install Fiery Bridge, see “Installing user software on a Windows computer” on page 12.

Configuring Fiery Bridge
To use Fiery Bridge, you must configure the connection to the Integrated Fiery Color Server 
by completing the following tasks:

• Specify one or more Integrated Fiery Color Server servers that you want to access.

• Configure settings for each server.

Details are provided in the following procedures.
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Specifying servers

When you start Fiery Bridge for the first time, the list of servers is empty. You must locate the 
servers on the network and add them.

TO START FIERY BRIDGE

• Choose Start > All Programs  >  Fiery  > Fiery Bridge or double-click the Fiery Bridge shortcut on 
your desktop.

TO ADD A SERVER TO FIERY BRIDGE

1 Click Add Server. 

2 If the Integrated Fiery Color Server that you want to add appears in the list of available 
printers, select the Integrated Fiery Color Server and click OK.

If the Integrated Fiery Color Server that you want does not appear in the list of available 
printers, select “Enter printer name or IP address”, type the DNS name or IP address of the 
Integrated Fiery Color Server, and click OK.

The Integrated Fiery Color Server is located on the network and added to the list of servers.

TO DELETE A SERVER FROM FIERY BRIDGE

1 Select the Integrated Fiery Color Server server from the list.

2 Click Delete. 

3 Click OK to confirm the deletion.

Configuring server settings

You can configure settings for any of the servers in the list. Currently, the only setting is the 
file format (PDF or TIFF) for a scanned document. Scanned documents do not reside on the 
Integrated Fiery Color Server server in PDF or TIFF format. However, when you transfer a 
scanned document from a Integrated Fiery Color Server to your computer using Fiery Bridge, 
the document is converted to either PDF or TIFF format, depending on the setting you 
configure.

TO CONFIGURE THE FILE FORMAT SETTING FOR THE INTEGRATED FIERY COLOR SERVER

1 Select the Integrated Fiery Color Server server from the list.

2 Click Settings.

3 Choose PDF or TIFF from the File Format list.

4 Click OK.
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Using Fiery Bridge
When you install Fiery Bridge, a Fiery icon is added to the My Computer window on your 
desktop. When you add an Integrated Fiery Color Server server to Fiery Bridge, a folder for 
that server is added under the Fiery icon. The folder for the server in turn contains a My 
Documents folder that contains the documents in your mailbox on the Integrated Fiery Color 
Server.

The scanned documents appear as regular files of either PDF or TIFF format (depending on 
the file format setting). However, these files are not actually on your computer. By default, a 
scanned document is not transferred to your computer until you access it by opening it in an 
application on your computer or by copying it to your computer. 

You cannot save a scanned document back to the Integrated Fiery Color Server mailbox. You 
must save it as a new document on your computer. The scanned document on the Integrated 
Fiery Color Server remains unchanged.

You can access scanned documents by browsing from the desktop, from within an application, 
or from the Fiery Bridge main window.

TO ACCESS A SCANNED DOCUMENT FROM YOUR DESKTOP OR AN APPLICATION

1 From your desktop, open My Computer. 

From an application, choose File  >  Open and browse to My Computer.

2 Under My Computer, open the Fiery icon.

3 Under the Fiery icon, open the folder that has the same name as the Fiery containing the 
scanned document.

4 If you are prompted for a user name and password, type them and click Login.

Select “Save User Information” before clicking Login if you want Fiery Bridge to enter your 
user name and password automatically in the future, even if you reboot your computer. 

5 Under the folder that has the same name as the Integrated Fiery Color Server containing the 
scanned document, open My Documents.

The list of scanned documents appears.

6 If you are browsing from your desktop, double-click a document to open it in its default 
application, or select a document and copy it to another folder. 

If you are browsing from an application, select the document and click Open.

A document is not transferred to your computer until you open it or copy it.
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TO ACCESS A SCANNED DOCUMENT FROM THE FIERY BRIDGE MAIN WINDOW

1 In the Fiery Bridge main window, double-click the Integrated Fiery Color Server that you want 
to access.

2 If you are prompted for a user name and password, type them and click Login.

Select “Save User Information” before clicking Login if you want Fiery Bridge to enter your 
user name and password automatically in the future, even if you reboot your computer. 

The My Documents folder for the Integrated Fiery Color Server that contains the scanned 
documents is opened in Windows Explorer.

Mailbox synchronization

If you want scanned documents transferred to your computer as they are available (to 
accommodate a particular workflow, for example), you can set up mailbox synchronization. 
With mailbox synchronization, scanned documents are transferred to your computer to a 
specific folder (different from the My Documents folder for the server) as they are created. If a 
scanned document is deleted from your Integrated Fiery Color Server mailbox, the file is 
deleted from the folder on your computer, as well.

TO CONFIGURE MAILBOX SYNCHRONIZATION FOR A FIERY

1 Select the Integrated Fiery Color Server server from the list.

2 Click Mailbox Synchronization.

The Mailbox Synchronization dialog box appears.

3 Select Mailbox Synchronization.

4 Type the user name and password for the Integrated Fiery Color Server.

5 Click Test Connection to test your connection to the Integrated Fiery Color Server.

Fiery Bridge attempts to connect to the Integrated Fiery Color Server using the information 
you provided and shows whether it was successful.

6 If PaperPort is installed on your computer, you can select Add to PaperPort. 

Select this option to add a shortcut to your Integrated Fiery Color Server mailbox in 
PaperPort.

7 Click OK.

NOTE: The path name of the folder that scanned documents are transferred to is shown in the 
Mailbox Synchronization dialog box. You cannot change this folder location.
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Accessing a different mailbox

After you log on to an Integrated Fiery Color Server, you remain logged on until you log out 
of your Windows session. To access a different mailbox on the same Integrated Fiery Color 
Server, you must log on as a different user.

TO ACCESS A DIFFERENT MAILBOX ON A SERVER YOU HAVE ALREADY LOGGED INTO

1 On your desktop, open My Computer.

2 Under My Computer, open the Fiery icon.

3 Under the Fiery icon, right-click the folder that has the same name as the Integrated Fiery 
Color Server that you want to access and click Login As.

4 Type your user name and password and click Login.

Accessing WebTools

You can access WebTools for any Integrated Fiery Color Server you have added to Fiery 
Bridge.

TO ACCESS WEBTOOLS FROM FIERY BRIDGE

1 In the Fiery Bridge main window, select the Integrated Fiery Color Server server from the list.

2 Click WebTools. 

The default browser is started and directed to the selected Integrated Fiery Color Server.
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HOT FOLDERS

Hot Folders is a utility that allows you to store and reuse frequently used print options when 
printing PostScript and PDF files on the Integrated Fiery Color Server. With Hot Folders, 
you can do the following:

• Create special folders (hot folders) that assign specific print settings and print queues 
to jobs

• Print jobs to the Integrated Fiery Color Server by dragging and dropping them onto hot 
folders on your computer’s desktop

• Monitor the status of jobs sent to hot folders

Installing Hot Folders
The installer for Hot Folders is located on the User Software DVD.

Before installing the utility, make sure that you complete the preliminary procedures 
described on page 10.

To install Hot Folders on a Windows computer, see “Installing user software on a Windows 
computer” on page 12. To install Hot Folders on a Mac OS computer, see “Installing user 
software on a Mac OS computer” on page 14.

Using Hot Folders
Complete instructions on how to use the standard Hot Folders features are provided in Hot 
Folders Help.

TO ACCESS HOT FOLDERS HELP

1 Start Hot Folders.

2 Choose Help  >  EFI Hot Folders Help.
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Additional features
The following section describes additional features of Hot Folders that are not discussed in 
Hot Folders Help.

Preserve Document Setting

When you define Job Settings for a new Hot Folder and open the Job Properties window, the 
default for many settings is displayed as Preserve Document Setting. This setting allows you 
to keep the job properties you set when creating the original job in the application.

About Hot Folders filters

Hot Folders filters allow you to convert certain file formats to PostScript or PDF or to 
preflight files for conformity. File conversion and preflighting take place on your computer 
within Hot Folders, which saves Integrated Fiery Color Server resources. You can print files 
directly from Hot Folders filters without starting the application from which they were 
created.

Using the PDF to PS filter

The PDF to PS filter is standard. The PDF to PS filter accepts PDF (v1.2 through v1.7) files 
and outputs PostScript files. 

NOTE: The filter converts any PDF v1.2 files to PDF v1.7 files, and then to PostScript Level 3 
files before submitting to the Integrated Fiery Color Server.

NOTE: This filter is not supported on Mac OS X.

Microsoft Office filters for Hot Folders

The Microsoft Office filters for Hot Folders feature allows you to convert certain MS Office 
file formats to PostScript. File conversion takes place on your computer within Hot Folders, 
which saves Integrated Fiery Color Server resources. You can print files directly from Hot 
Folders filters without starting the application from which they were created.

The Microsoft Office filters have no configurable options; however, you must have the 
following versions of each application, and have Acrobat Distiller installed to convert the files 
to PostScript files.

• Microsoft Excel 2000 and higher

• Microsoft Publisher 2002 and higher

• Microsoft PowerPoint 2000 and higher

• Microsoft Word 2000 and higher

NOTE: Office 2007 filters are not supported.
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Specifying filter settings for a Hot Folder

After specifying the filter settings and options for your Hot Folder, drag and drop the proper 
file formats onto your Hot Folder to begin the conversion process.

Open the Filter Settings dialog box from the Folder Properties dialog box.

TO SELECT A FILTER SETTING

1 From the Hot Folders Control Panel, select the Hot Folder and click Properties.

2 Select Filter Settings and click Define.

The Filter Settings dialog box appears, allowing you to select the filter. 

For Windows, filters are color-coded. Exclusive filters are blue and Non-exclusive filters are 
black. 

If you select an Exclusive filter, you cannot select any other filter. Microsoft Office filters are 
non-exclusive filters, so you can select as many of them as you wish.

3 To convert all PostScript files to PDF automatically, select Convert PS to PDF and a job option 
from the Distiller Profile menu in the PS->PDF Normalizer pane.

4 Click OK.



WEBTOOLS 58
WEBTOOLS

WebTools allow you to manage your Integrated Fiery Color Server remotely from the Internet 
or your company’s intranet. The Integrated Fiery Color Server has its own home page, where 
you can select the following WebTools:

• Home provides current information about the jobs processing and printing on the 
Integrated Fiery Color Server.

• Downloads allows remote users to download installers (for drivers, PPDs, and other 
software) directly from the Integrated Fiery Color Server.

• Docs allows remote users to access jobs on the Integrated Fiery Color Server over the 
Internet or intranet. 

• Configure allows the Integrated Fiery Color Server administrator to view and modify Setup 
options remotely from a Windows computer.

• Scan Settings allows the Integrated Fiery Color Server administrator to create Scan 
Templates.

Setting up WebTools
WebTools are resident on the Integrated Fiery Color Server hard disk and do not require 
special installation. However, WebTools do require initial setup by the Integrated Fiery Color 
Server administrator.

To enable network users to access and use WebTools, the administrator must set specific 
options in Network Setup and Printer Setup. For information about these specific Setup 
options, see Configuration and Setup.

The administrator also must prepare each user’s computer to communicate with the 
Integrated Fiery Color Server over the Internet or intranet.
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TO SET UP CLIENT COMPUTERS TO USE WEBTOOLS

1 Enable TCP/IP networking.

2 Make sure that the computer has a valid, unique IP address.

3 Make sure that a supported Internet browser is installed on the computer.

For more information about supported browsers, see Welcome.

4 Make sure that Java is enabled in your Internet browser.

In addition, make sure that you have completed the preliminary procedures described in 
“Preparing for installation on Windows computers” on page 10.

NOTE: If the client computer is running Windows XP with Service Pack 2 (SP2) installed, 
Pop-up Blocker is turned on by default. With this function turned on, a warning message 
appears when you access WebTools, and your access to WebTools is denied. To gain access, do 
one of the following:

• Change the Pop-up Blocker setting by clicking the warning message and choosing from 
one of the selections that appears.

• Turn off Pop-up Blocker in Internet Explorer from the Tools menu or in Internet Options.

For more information, see Internet Explorer Help, or the documentation that accompanies 
Windows.

Accessing the WebTools home page
Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO ACCESS THE WEBTOOLS HOME PAGE

1 Start your Internet browser. 

2 Type the IP address or DNS name of the Integrated Fiery Color Server.

The Integrated Fiery Color Server home page appears. 

If the home page for the digital press appears instead of the WebTools page, click the 
WebTools link.

3 Click the tab for the WebTool that you want to use.
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Using WebTools
The following sections describe how to use the WebTools.

Home

Home lets you view jobs that are currently processing and printing on the Integrated Fiery 
Color Server. Printing and processing information is updated every 30 seconds.

For complete instructions on how to use Home, see WebTools Home Help. 

Downloads

The Downloads WebTool allows you to download installers (for drivers, PPDs, and other 
Integrated Fiery Color Server software) directly from the Integrated Fiery Color Server.

For complete instructions on how to use Downloads, see WebTools Downloads Help. 

Docs

Docs allows you to access jobs on the Integrated Fiery Color Server over the Internet or 
intranet. You can: 

• Manage and distribute jobs in your mailbox. 

Mailboxes are set up in the Users and Groups area of the Configure WebTool.

• Control and modify jobs.

• Submit jobs to the Print Server.

For complete instructions on how to use Docs, see WebTools Docs Help. 

Configure

Configure allows the Integrated Fiery Color Server administrator to view and modify Setup 
options remotely from a Windows computer. For information about using Configure, see 
Configuration and Setup. 

Before using Configure, make sure you have completed the Configure preparation procedure 
described in “Preparing for installation on Windows computers” on page 10.

For complete instructions on how to use Configure, see WebTools Configure Help. 
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Scan Settings

Scan Settings allows the Integrated Fiery Color Server administrator to set up Scan Templates. 
These scan templates are accessible from the digital press control panel, by pressing either 
Network Scanning or Web Applications. The Network Scanning digital press control panel 
displays the default digital press scan templates, as well as any that have been set up through 
WebTools Scan Settings. 

TO CREATE A SCAN TEMPLATE

1 On the WebTools Home page, click the Scan Settings tab.

2 Log in as Administrator. 

Only Administrators can create Scan Templates.

3 Click the New icon.

4 In the General Settings area, enter a name for your new scan template and, if desired, a 
description.

5 In the Scan Destination area, select the destinations you want and enter the required 
information.

You can send a scan to a Mailbox, E-Mail, FTP server, or SMB location.

6 In the Document Settings and Scan Enhancements areas, select your choices from the menus 
for each option.

7 Click Save. To reset the defaults, click Reset.

The newly created Scan Template appears on the digital press control panel. 

For complete instructions on how to use Scan Settings, see WebTools Scan Settings Help. 
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